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Introduction
Windows 7 is the latest version of Microsoft’s 
operating system. It includes a number of 
improvements over earlier versions of Windows, with 
better security and performance. It’s also easier to 
customise your computer to suit your way of working.

but please see our website for more details, including 
links to useful videos and online help. 

Logging on
Hold down the 
Control, Alt and 
Delete keys, enter 
your username and 
password and then 
press Enter, or click 
on the blue arrow 
icon next to the 

log on.
3



Using Windows 

First glance
In the latest version of Windows, you have much 

on the Desktop and Start menu. Initially you have a 
virtually blank desktop which you can organize and 
customize to suit your preferences.

Click the Using this PC 
icon for more information 
and help.

The Start button
The Start button now has the Windows icon instead 
of the word Start, but it still works in the same way - 
click on it to open the Start menu.4
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Using the Start menu
Initially, no programs are shown in the Start menu. To 

by clicking on All Programs. 

Example: open Word by browsing
click on the Start button and then All Programs

 folder and click to 
expand it

3 click on 

After you open it, the program will stay in the start 
menu, with the programs you use most often shown 
at the top of the list.

If you want to make sure a particular program is 
always shown in the list, you can ‘pin’ it.

Pin a program to the Start menu
right-click on the program name in the Start 
menu and choose Pin to Start Menu.

Pinned programs are shown in a separate section 
at the top of the Start menu with frequently used 
programs underneath.



When you start typing a word or phrase in the search 
box, the search begins automatically, and the search 
results will appear.

The search results are 
organized into groups, 
depending on the kind of item 
and where it’s located on your 
computer. You can click an 
individual result to open that 

click a group heading to see 
the complete list of search 
results for that group. 

This can be quicker than 
browsing when you want to 

open a program that’s not already on the Start menu.

click on the Start button
in the search bar, type  and if the program 
is installed on your computer, it will be shown in 
the results

3 
in the search results - you can also click on any 
item in the list to open it
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Managing windows 

web pages, you can now use the Taskbar and mouse 
rollover to switch quickly between them.

hover over the program icon in the Taskbar to 

To see or get back 
to the desktop 
quickly, move 
your mouse 
cursor to the 

unlabelled button 
in the corner of the 
screen:

hover to make all current windows transparent
click on it to automatically minimise all open 
windows and show the desktop

the 
Taskbar



Snap windows to the top or sides
click on the top section of the window and drag it 
right to the top of the screen and then release to 

drag to one side 

screen - to compare 
windows side by 
side, drag one to the 
left and the other to 
the right

Minimise all other windows
For most programs, if you want to concentrate on one 
window and minimise all the others quickly:

click and hold the title bar at the top of the 
window you want to use
shake it from side to side a few times and the 
others will be minimised

3 click, hold and shake again to restore the other 
windows



Windows 7 introduces Jump Lists for both the 
Start menu and the Taskbar. Jump Lists are like 

used recently. You can also pin favourite items to a 
list, so that you can easily get back to them.

click the Start button, and then hover the cursor 
over the  the program’s name in the start menu
the right-hand panel will now change to show the 
Jump List for 
that program

3 move the 
cursor over 
the item you 
want to pin 
and you will 
notice a small grey pushpin icon next to it

4 click the pushpin icon to pin it to the list and the 
item will be placed in the Pinned section at the 
top of the list

5 to unpin the item, move the cursor over the 

pushpin icon - click it to unpin

in the start menu, search or browse to a program
right-click on the program name in the start 
menu and choose 



hover over the icon for the program and right-
click
you will see the Jump List for the program and 
can move the cursor over the 
items to get the pushpin icon

You can also:

add it to the Jump List of the 
appropriate program (and pin 
the program if it isn’t already)

If you prefer, you can also add a desktop shortcut to 

right-click on an empty part of the desktop
choose New and then 

browse to the location 
of the program or 
enter the web address
click Next, enter a 
name and then Finish



If you click on the Start button and then Computer, 
you will see the locations you 

For most purposes, it’s best to 
use your N: drive because:

backed-up daily
if you need to, you can get 
access to them from other 
computers on or off campus

If you are a member of staff, you may also have 
access to shared drives, for example, a G: drive for 
your department.

On the left-hand side of the window, 
you will also see your standard 
Libraries: , , 

 and Videos. These point 
to folders with the same name on 

Documents, it will be stored in 
N:/Documents.

If you accidentally delete one of the four standard 
libraries, you can easily restore it: right-click Libraries 
in Windows Explorer and then Restore default 
libraries.



Printing
When you come to use the printing service, you 
should be able to choose an appropriate printer from 
those nearby.

printer you want to use (for example, library_
 for the black and white printers in the 

choose File and then Print
3 select your printer from 

the drop-down list

Click on the icon in the 
Taskbar at the bottom right 
of the screen to check you 
have enough credit to print.

If you’re a member of staff, you will also want to set 
up your default printer after your computer has been 
upgraded to Windows 7.

from the Start button, choose 

right-click on the printer you use 
most often

3 choose Set as default printer



Browsing the web  

Using Internet Explorer

it, many of the controls are hidden to allow more 
space for the web page.

Display the standard menu
right-click on the clear area 
at the top of the window
choose Menu bar and 
it will appear below the 
address bar

The search window has now been combined with 

terms into the window and press enter or click on the 
magnifying glass icon. 

You will then be shown results from Bing which is 
Microsoft’s search engine. 



click the Tools icon      in the top right of the 
window
choose Manage 
Add-ons

3 click on 
Providers and 
then choose 

 or 

4 click on the Set as default button

click on the Favorites icon      in the top right of 
the window
use the tabs to look at your 
bookmarks (Favorites) or 
browsing History

3 click on the small icon with 
a green arrow      to pin the 
section on the left of the 
window if you want it displayed 
all the time you’re browsing

Open pages in tabs
You can have several web pages open at the same 

top of the window.



To open a new web page without  
closing the one you’re on, click the new tab button.

Compatibility view
Sometimes when you’re browsing the web, you may 

If so, you can see them as they would have looked 
in an earlier version of Internet Explorer by using the 
compatibility view.

This is a small icon in the address bar which looks 
like a torn page - if you click on it, it will turn blue to 

layouts and displays, especially on older web pages.

Other problems with web pages? 
If you encounter other issues, such as problems 
displaying videos or particular web sites, a quick 
solution is to try with a different web browser. IT 
Services computers now include Firefox as an 
alternative to Internet Explorer (see over).

Compatibility view 
switched on



Browsing with Firefox
The Firefox browser offers some different features 
and enables you to take advantage of a large 
selection of add-ons.

Install an add-on
click on the orange Firefox button in the top left 
corner
choose Add-ons

3 enter the name of the add-on in the search box 
and press enter

4 click the Install button for your add-on

Set a home page
click on the orange Firefox button in the top left 
corner
choose Options

3 on the  tab, type the address for your 
preferred site in the Home Page 

4 alternatively, click Use Current Page to set the 
site you’re currently on to be your home page

5 click 



Finding a command

Word, Excel or Powerpoint, a set of tabs are displayed 
along the top of the screen with a strip containing 
sets of icons. This area is called the Ribbon. 

Click on the tabs along the top to see a different set 
of related commands.

Certain tabs only appear when you need them, for 
example Tables, Drawings and Charts. But you 
can now create your own tabs with your choice of 
commands.

click on File, then Options and Customise 
Ribbon

Tabs Show or hide the ribbon

Groups of commands



choose New Tab and select it
3 click Rename and choose a label for it
4 choose , select and Rename it
5 make sure the new group is highlighted

and click Add to place them on the Ribbon

The Quick Access Toolbar is a small area to the upper 
left of the Ribbon where you can save commands you 
use frequently including Save, Undo and Repeat.

click on the More symbol     and click on the 
command you want to add
or, right-click on any command on the Ribbon 
and choose 

The File tab is highlighted to show that it behaves 
differently from other tabs. Click on File to show 
a page called the  which shows 

New, Save, 
Open, Close and Print.



click on File and then  (if it’s not already 
highlighted)

recent folders you’ve used on the right

click on File and then Print
the print preview is shown automatically on the 
right, next to the options for the printer and page 
setup

3 click on the Print

Create a PDF
click on File and then Save & Send
choose then click 
on the
button

The File tab also gives access 
to the Options to control 
how the program looks and 
behaves.



New features
There are a number of new tools and functions in the 

See our website for more information about how to 
get the most out of the new versions.

The new features include:

Quickly navigate the 
headings in a Word 
document

Filter pivot table data 
more easily in Excel

Embed videos
Better embedding of 
videos in Powerpoint

Include screenshots 
more easily in Word, 
Excel and Powerpoint

Add tiny charts into cells 
in Excel spreadsheets

Edit photographs from 
within Powerpoint



The latest version of Microsoft’s email and 

included on all staff PCs, but not on the computers in 
student cluster rooms. 

Most functions will be familiar to users of previous 
versions but there are some new features. For 
example, Outlook commands are now displayed on a 

Setting up
There are a number of things you may like to do to 

Change the layout
click on View
in the Layout section, click on Reading Pane

3 change to Bottom to make the layout similar to 
other email programs

click on View
in the Conversations section, untick Show as 
Conversations

3 click on All folders in the pop-up window

Set up your signature
click on the File button in the top left



choose Options in the left-hand pane
3 click Mail in the left-hand menu and then the 

Signatures... button
4 click on New and give your signature a name
5 type and format your signature in the lower part 

of the window
to use the signature automatically, use the New 
messages drop-down list to choose the signature 

7 do the same for  if appropriate

Prevent grouping of emails in the message list
click on the View tab and in the 
Arrangement section, click on the 
small down arrow for more options
untick 

Schedule view

to look across a series of calendars when trying to 
book a meeting.

In the calendar section, in addition to the normal 
day/week/month view, the new schedule view can 

when comparing several calendars. 

in the calendar section, on the Home ribbon, 
click on  (in the Arrange gallery) 
add the calendars you want to compare



3 double-click on the top row at the chosen time to 
create a meeting with all recipients

You are given a horizontal 
view of the calendars and 

time to arrange a meeting.

Calendar preview
When you receive an 
invitation to a meeting, you might want to check 

appointment. 

provides a quick preview 
of your calendar around 
that time, making it easier 
to decide if you’re able to 
attend.

Searching

emails more easily.

click into the search bar above the email list
use the options on the
your search

3 
search all mail items 



Further information

Web
sussex.ac.uk/its/windows7

Email
support@sussex.ac.uk

Shawcross open Monday-Friday

University of Sussex


